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Legal Statement

Copyright © 2020, LSOFT TECHNOLOGIES INC. All rights reserved. No part of this documentation may
be reproduced in any form or by any means or used to make any derivative work (such as translation,
transformation, or adaptation) without written permission from LSOFT TECHNOLOGIES INC.

LSOFT TECHNOLOGIES INC. reserves the right to revise this documentation and to make changes in
content from time to time without obligation on the part of LSOFT TECHNOLOGIES INC. to provide
notification of such revision or change.

LSOFT TECHNOLOGIES INC. provides this documentation without warranty of any kind, either implied
or expressed, including, but not limited to, the implied warranties of merchantability and fitness for a
particular purpose. LSOFT may make improvements or changes in the product(s) and/or the program(s)
described in this documentation at any time.

All technical data and computer software is commercial in nature and developed solely at private expense.
As the User, or Installer/Administrator of this software, you agree not to remove or deface any portion
of any legend provided on any licensed program or documentation contained in, or delivered to you in
conjunction with, this User Guide.

Active@ Disk Clone Industrial, the Active@ Disk Clone Industrial logo, Disk Clone Industrial are
trademarks of LSOFT TECHNOLOGIES INC.

LSOFT.NET logo is a trademark of LSOFT TECHNOLOGIES INC.

Other brand and product names may be registered trademarks or trademarks of their respective holders.

Introduction

Disk Clone Industrial (drive duplication unit) is a vital tool used to manage and protect data. Why to
clone:

• Simplest case: Hard Disk Upgrade! Disk Clone can help to upgrade hard disk from old small disk
to a new larger one without re-installations of operating system and the applications

• OS Transfer: Cloning a disk with ANY OS installation enables to transfer OS to another hard drive
or much faster SSD without reinstalling

• Make a Duplicate Disk: If all the data on the current system installed disk are important, it is
necessary to do a complete backup of the source disk by cloning it to a target disk

• Data Recovery: In order to avoid secondary damage to the hard disk during data recovery, it is
necessary to clone the disk and then restore what you want from the cloned disk

• "REBOOT AND REFRESH": an option for public computers
• "RESET": to return a system to an original configuration with no personal data before selling or

giving a computer away
• Set up multiple computers with identical configurations

Related information
File Browser on page 65

Cloning Data
Disk cloning is an act of copying the contents of a computer's physical drive byte by byte onto another
physical drive. The contents are typically saved as a disk image file and transferred to a storage medium,
which could be another computer's hard drive or removable media such as a DVD or a USB drive.
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Disk Clone Industrial is an affordable industrial-grade disk duplication hardware solution supporting
parallel cloning of multiple disks. Easy to use, extremely quiet and energy efficient. Supports cloning
physical disks, ISO images or compressed Disk Images to different type of media: HDD/SSD/NVMe/USB.

Related tasks
Disk Clone
Related information
Clone Sources on page 80

Erasing Confidential Data
Modern methods of data encryption are deterring network attackers from extracting sensitive data from
stored database files.

Attackers (who want to retrieve confidential data) become more resourceful and look for places where
data might be stored temporarily. For example, the Windows DELETE command merely changes the files
attributes and location so that the operating system will not look for the file. The situation with NTFS is
similar.

One avenue of attack is the recovery of data from residual data on a discarded hard drive. When deleting
confidential data from hard drives, removable disks or USB devices, it is important to extract all traces of
the data so that recovery is not possible.

Most official guidelines regarding the disposal of confidential magnetic data do not take into account the
depth of today's recording densities nor the methods used by the OS when removing data.

Removal of confidential personal information or company trade secrets in the past might have been
performed using the FORMAT command or the FDISK command. Using these procedures gives users a
sense of confidence that the data has been completely removed.

When using the FORMAT command Windows displays a message like this:

Important: Formatting a disk removes all information from the disk.

The FORMAT utility actually creates new FAT and ROOT tables, leaving all previous data on the disk
untouched. Moreover, an image of the replaced FAT and ROOT tables is stored so that the UNFORMAT
command can be used to restore them.

FDISK merely cleans the Partition Table (located in the drive's first sector) and does not touch anything
else.

Disk Clone Industrial is able to erase data on entire drive with a choice of One Pass Zeros and One Pass
Random international disk sanitizing standards

Related tasks
Disk Erase
Related information
Erase Disk Concepts on page 96
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 Disk Clone Overview

Disk Clone for Industrial Systems

This edition of Disk Clone is designed to provide a software solution for industrial workstations,
configured to service disks in high volumes. Disk Clone for Industrial Systems is distributed as a
software package that may be installed on a disk erase workstation and used to examine, erase and
even write images to individual or batches of disks. Highly customizable, the software is able to conform
to any company standards - erasure standards, examination type, reporting, error handling are only a
subset of the configurable settings Disk Clone supports. All elements of Disk Clone operations may be
documented in XML reports, PDF certificates, or even printable labels for erased hard drives. Versatile,
easy to navigate and rich in features, Disk Clone for Industrial Systems is the ideal disk cloning
solution for corporations to securely erase and clone hard drives as well as their images - simply and
efficiently.

Customizable interface allows to define layouts, batches and processing automation. Supports cloning Hard
Disk Drives, solid state drives (SSD) and latest NVMe disks, SATA and SAS disks, external disks via eSATA
and USB. Cloning any file systems and operating systems: Windows, Linux/Unix, MacOS.

Disk Clone is a powerful software that delivers the following main features:

• Parallel cloning of up to 20 disks from a single source
• Clone ALL known file systems and operating systems
• Fast erase data on entire drive, supports parallel erasing of large numbers of drives (hardware-

limited)
• Destroy data with a choice of One Pass Zeros or One Pass Random international disk sanitizing

standards
• Disk Clone allows you to write an image or copy a Master Disk/Partition to newly erased hard

drives with its cloning feature
• Sanitize and clone external disks (USB drives, external HDD/SSD) connected to both USB 2.0 and

3.1 ports
• Auto-erase mode sanitizes disks and prints certificates without of any user interaction
• Hot-swap operations are fully supported, erase could be auto-initiated upon HDD plug-in
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• Browse file systems on disk volumes and inspect particular sectors Hex Viewer on a low level
• Print different types of labels to be attached to hard disks after erase completion
• Provides enhanced information about disks and their attributes including S.M.A.R.T. monitoring
• And more...

Related information
Erase Methods (Sanitation Standards) on page 98

System Requirements
Disk Clone Industrialis designed to run on Linux and Windows operating systems with the following
minimum requirements:

Workstation

• IBM PC compatible machine
• Intel Pentium or higher
• 2 Gb of RAM
• 100Mb of free disk space

Workstation

• IBM PC compatible machine
• Intel Pentium or higher
• 2 Gb of RAM
• 100Mb of free disk space

Video

• VGA (1024x768) resolution or better

Video

• VGA (1024x768) resolution or better

Operating Systems

• Windows XP or higher
• Linux Kernel 2.x or higher

Operating Systems

• Windows XP or higher
• Linux Kernel 2.x or higher

Drive Storage

Disk types supported:

• IDE
• ATA
• SSD
• SATA
• eSATA
• SCSI
• NVMe

Drive Storage

Disk types supported:

• IDE
• ATA
• SSD
• SATA
• eSATA
• SCSI
• NVMe

Disk Clone Industrial works with all drives supported by the Operating System with read/write access

Related information
Disk Clone Installation and Distribution on page 12

Software Licensing
Disk Clone Industrial is supplied with a security USB key that contains number of licenses being
purchased (one license is required per slot where HDD/SSD is plugged into).
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Figure 1: Security USB license key

This key must be inserted into any USB slot on the PC before running Disk Clone software, otherwise
authorization error appears.

Software Updates
Disk Clone has a built-in update client to ensure you always have access to the latest version of the
application. To update, use the file menu bar to navigate to Help > Check for Updates

Figure 2: Checking for updates

Update dialog contains history of previously installed versions and updates.

If a new version or update is detected it can be downloaded and installed on the next wizard steps.

Note:  Disk Clone stores your previously installed versions so you may roll back to any of your
older versions at any time.
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Getting Started with Disk Clone Industrial

This section describes the key features of Disk Clone Industrial and explains basic functionality.
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 Disk Clone Installation and Distribution
Disk Clone Industrial is distributed as a software solution with a DVD-ROM and security USB license.
DVD-ROM contains two installations:

• DiskCloneIndustrial-Setup.exe - installation for Windows OS
• DiskCloneIndustrial.run - installation for the Linux OS

Simply install the application into your data erasure workstation environment and configure it.

Launching and initial Configuration
Note:  Before launching Disk Clone make sure the security USB stick is plugged into the
workstation's USB slot.

Upon first launching the application you will encounter the Disk Bay Layout Wizard.

Figure 3: Disk Bay Layout Wizard

This menu allows you to initialize Disk Clone to display your hardware in an intuitive way. To illustrate the
purpose of this read this section on Disk Bay Layouts. This initial configuration can be done in 1 of 3 ways:

Load predefined layout
Here you can find 1 of our predefined layouts that may fit your system. If an appropriate layout is not listed
you may try the next option

Load predefined layout
Here you can find 1 of our predefined layouts that may fit your system. If an appropriate layout is not listed
you may try the next option

Generate default Disk Bay layout
Define your hardware in terms of a disk array arranged in a X by Y grid of disks. You may make adjustments to
this later so this may just be a template to start from

Generate default Disk Bay layout
Define your hardware in terms of a disk array arranged in a X by Y grid of disks. You may make adjustments to
this later so this may just be a template to start from
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Automatically generate Disk Bays for all discovered disks
Defines your Disk Bay layout based on the disks recognized by your system's device manager. The disks
will be placed in their own individual row when the layout is generated. The result could be looking as the
following:

Figure 4: Disk Bay View (automatically generated)

Automatically generate Disk Bays for all discovered disks
Defines your Disk Bay layout based on the disks recognized by your system's device manager. The disks
will be placed in their own individual row when the layout is generated. The result could be looking as the
following:

Figure 4: Disk Bay View (automatically generated)
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Figure 5: Disk Bay Tree View (automatically generated)Figure 5: Disk Bay Tree View (automatically generated)

Related information
Security Hardware
Disk Layout Overview on page 16

Navigating Disk Clone
Once the Disk Clone application is launched the main application's dashboard appears. From here you
can use any of Disk Clone's tools on your system.  This section describes the main components of the
application. The full functionality and features of these components are discussed in their corresponding
sections later.
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Figure 6: Disk Clone Industrial application dashboard

Where:

1 - Tabbed Windows
Here you can navigate between Disk Clone tabbed windows such as Disk Explorer, Application Log etc..
1 - Tabbed Windows
Here you can navigate between Disk Clone tabbed windows such as Disk Explorer, Application Log etc..

2 - Command Toolbar
The command toolbar is a dynamic toolbar that allows the user to perform Tabbed Window-specific actions
(depending on the context).

2 - Command Toolbar
The command toolbar is a dynamic toolbar that allows the user to perform Tabbed Window-specific actions
(depending on the context).

3 - View Selection
This View Selection (only available in Disk Explorer View) allows you to manipulate how the Bays are
displayed in the Windowed View as well as manipulating with type of graphics used to show the Bays in
Disk Bay View.

3 - View Selection
This View Selection (only available in Disk Explorer View) allows you to manipulate how the Bays are
displayed in the Windowed View as well as manipulating with type of graphics used to show the Bays in
Disk Bay View.

4 - Windowed view
Contains the window that is currently active. By default you can see here all HDD/SSD/USB disks attached to
the workstation.

4 - Windowed view
Contains the window that is currently active. By default you can see here all HDD/SSD/USB disks attached to
the workstation.

5 - Output window
Contains the log of operations Disk Clone has performed.
5 - Output window
Contains the log of operations Disk Clone has performed.
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6 - Batch control window
The Batch control window is an easily accessible interface to create, delete and manipulate disk batches.
6 - Batch control window
The Batch control window is an easily accessible interface to create, delete and manipulate disk batches.

7 - Advanced tool tabs
These tabs allow to navigate between the different Advanced Tool windows.
7 - Advanced tool tabs
These tabs allow to navigate between the different Advanced Tool windows.

8 - Advanced tool window
This window shows the data for the Advanced Tool selected. The window can be moved, popped out and re-
sized.

8 - Advanced tool window
This window shows the data for the Advanced Tool selected. The window can be moved, popped out and re-
sized.

To browse through each of these Views click on the appropriate tab. You may also open a View from the
View menu.

To open any closed View just select it from the View menu.

The status bar at the bottom of the workspace shows the current status of the application or status of the
activity in progress.

Related information
Using Disk Clone on page 35
Property Views

Disk Layout Overview
The purpose of Disk Bay Layouts is to match Disk Clone's graphical disks' representation to your actual
hardware configuration making it easy to manage disks for  cloning, erasure and more. To illustrate this
let's look at the example, using the hardware below:

Figure 7: Example of a generic disk array

In the example above we have a generic disk array consisting of 16 disks arranged in a 4x4 grid. The
machine using these disks would see the disks similarly to Disk Clone's Local Devices View:

© 1999 - 2020 LSoft Technologies Inc.



 | Getting Started with Disk Clone Industrial | 17

Figure 8: Local Devices View

Now imagine inserting a HDD into the bottom-leftmost Bay of the disk array. Even finding the device
in a list of 15 other disks would be tedious and not very intuitive. This is when creating a Disk Bay
Layout is extremely useful. By creating a 4x4 Disk Bay Layout we can map the physical ports to their
corresponding Bay in Disk Clone and visually see our disk array like this:
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Figure 9: Disk Bays View

Assuming that the Bays were mapped correctly finding the correct disk to manipulate with is now much
easier in the Disk Bays View than it would have been in Disk Bays View on page 28 or Local
Devices View on page 31. You can now select the bottom-leftmost disk in the Disk Bays View and
perform any necessary actions on it.

Related information
Editing Disk Bay Layouts on page 18
Export and Import of Disk Bay Layouts on page 22
Layouts Advanced Features on page 23

Editing Disk Bay Layouts

To create or edit current Disk Bay Layout select Edit > Edit Disk Layout in the menu or use a shortcut
CTRL + M.
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Figure 10: Opening the Disk Bay Layout View

This will bring you to the Disk Bays Layout View where you can manipulate, save, import and create
Disk Bay Layouts.
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Figure 11: Disk Bays Layout View

There are 2 types of layouts:

• Free Grid Layout allows user to place Disk Bay widget at any position, change Bay widget
size and its alignment (vertically or horizontally) individually for each Bay. Hence, user can create
relatively accurate mocking layout of actual (physical) disk Bay slots located on hardware chassis

• Table Layout is similar to Disk Bay Layout from previous versions. However, now user can re-size
or select Disk Bay widgets by using row and column headers

Creating a new layout

To create a new layout select either >Free Grid or Table layout option and start adding Disk Bays using
circled "+" symbols.
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Figure 12: Editing Disk Bay Layout

If predefined layout already exists click Clear Layout to remove it and create a new one.

Editing Disk Bay layout

• Click on circled “+” signs to add new Disk Bay widget on a side of existing one. New Disk Bay
widget size will be corresponded to adjusted Disk Bay

• To re-size Disk Bay use mouse to drag it's right side or bottom
• To set Disk Bay vertically-oriented use mouse to drag it's right side to shrink it until it changes to

vertical state.
• To delete Bay(s) select it and press Delete keyboard key or use service menu by clicking “gear”

icon on left upper corner
• Use mouse to drag-n-drop selected Disk Bay widgets to new location. If hovered location is invalid

Disk Bay widgets will be highlighted with crossed sign
• To change disk label or port, click on corresponded labels on disk widget to start editing
• To change Disk Bay attributes use menu by clicking on “gear” sign on selected Bay

Important:  Due to different hard disk controller manufacture standards and platform limitations
physical disk port address format may vary.

Note:  If both platform name and disk port are assigned to Disk Bay widget then platform name
is used for Disk Bay mapping.

Disk Bay Layout Wizard

To create a new layout using the wizard click Customize > New Layout Wizard. This will launch the
Disk Bay Layout Wizard

© 1999 - 2020 LSoft Technologies Inc.
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Figure 13: Disk Bay Layout Wizard

This configuration of a new layout can be done in 1 of 3 ways:

Load predefined layout
Here you can find one of our predefined layouts that may fit your system. If an appropriate layout is not listed
you may try the next option.

Load predefined layout
Here you can find one of our predefined layouts that may fit your system. If an appropriate layout is not listed
you may try the next option.

Generate default Disk Bay layout
Define your hardware in terms of a disk array arranged in a X by Y grid of disks. You can make adjustments to
this later so this may just be a template to start from. Table-style layout will be created.

Generate default Disk Bay layout
Define your hardware in terms of a disk array arranged in a X by Y grid of disks. You can make adjustments to
this later so this may just be a template to start from. Table-style layout will be created.

Automatically generate Disk Bays for all available physical ports
Defines your Disk Bay Layout based on the disks recognized by your system's Device Manager. The disks will
be placed in their own individual row when the layout is generated.

Automatically generate Disk Bays for all available physical ports
Defines your Disk Bay Layout based on the disks recognized by your system's Device Manager. The disks will
be placed in their own individual row when the layout is generated.

Warning:  Make sure to save the layout by clicking Done otherwise your layout WILL be lost.

With the old layout cleared out you now have a new layout ready to be configured to your machine.

Saving and Reverting changes

Click Done button to commit any changes to the application View layout.

Note:  Done will apply current change to the application session so the changes will be seen in
the Disk Bays View and even be loaded in future application launch. These changes will not affect
the .dbl file.

Click Cancel to revert any changes you made to the layout.

Export and Import of Disk Bay Layouts

Once a Disk Bay Layout is configured it can be saved and later used with other Disk Clone
configurations. This is done with the Export and Import features.
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Exporting a Disk Bay Layout

Layouts are saved using the Disk Bay Layout command tool bar's commands. Select Customize then
Export Layout as... in the drop down list of commands. This will open a dialogue where the layout can
be configured by setting the Title, Description, File name and path to save the layout to. Once these
settings are configured click Save and the layout will be saved as a .dbl file in the specified location.

Figure 14: Export Disk Bay Layout dialog

Title
Enter any label to distinguish newly created Disk Bay Layout to differentiate it among
other Disk Bay Layouts.

Description
Describe all the specs and features of the new Disk Bay Layout.

Layout profile name
Select the name of the file that the Disk Bay Layout will be saved as. File extension
should remain as .dbl.

Importing a Disk Bay Layout

Saved Disk Bay Layouts are imported into separate application sessions using the Import feature. In the
command tool bar select Customize and Import Layout. Select the desired Disk Bay Layout (.dbl file)
in the file explorer window and click Open.

This will import the Disk Bay Layout into the current application session. Finally, click Done to update the
disks in the Disk Explorer and the import should be complete.

Layouts Advanced Features

Once a Disk Bay Layout is created there are a number of actions that can be performed to format or
manipulate the layout and appearance of the disks in the Disk Clone application.

Locking Disks

In order to prevent accidental deletion of important disks Disk Clone supports locking of disks. Once a
disk is locked no write operations are allowed to be performed on the drive. To do this simply find the disk
that needs to be locked and execute Bay Locked menu command from the Change disk bay attributes
drop down menu:
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Figure 15: Locking a disk to prevent accidental destruction

Figure 16: Locked Bay

Locking Clone Source

Disks that are planned to be used as master copy for Disk Clone could be marked in Disk Bay Layout by
selecting Disk Bay and clicking Clone Source from the Change disk bay attributes drop down menu.
Hence, disks marked this way will be protected from accidental destruction and also will be available in
devices' list as source for disk cloning.
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Saving and Reverting changes

Click Done button to commit any changes to the application View layout.

Note:  Done will apply current change to the application session so the changes will be seen in the
Disk Bays View and even be loaded in future application launch. These changes will not affect the
.dbl file.

Click Cancel to revert any changes you made to the layout.

Disk Explorer
The Disk Explorer is a default View and interface for the Disk Clone application. All the attached HDD/
SSD/USB disks are visualized can be selected and manipulated here. New procedures like erasure can
be initiated from here as well as displaying statuses and progress for actions performed with disks. There
are 3 available main Views: Disk Bays View on page 28, Local Devices View on page 31 and My
Computer View on page 33

Figure 17: Disk Bays View
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Figure 18: Local Devices View
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Figure 19: My Computer View

An additional toolbar helps to execute frequently performed tasks. It contains the following buttons with
drop-down menus:

View
The disk explorer supports a range of different Views to use when performing Disk Clone
actions, each with their own customizable settings for different use cases.

Customize
These settings (different for each View) let you customize appearance for better
experience for each View.

Related information
Preferences on page 75
Disk Bays View on page 28
Local Devices View on page 31
My Computer View on page 33
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Disk Bays View

This View displays the disks configured in the Disk Layout Editor. The Bays are grouped by their row,
colored by the batch color, and show the current status of the disk. If any operations are being performed
on the disk the operation status and progress are displayed.

Figure 20: Disk Bays View

Customize menu

New Layout Wizard
Launches the Disk Bay Layout Wizard

Import Layout
Imports saved (exported) layout (*.dbl)
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Figure 21: Disk Bay Layout Import

Export Layout as..
Exports custom (built) layout (*.dbl)

Figure 22: Disk Bay Layout Export

Show Partitions
Show or hide additional layout for partitions and volumes.

Toggle Rows as Columns
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This setting can be toggled on/off to display the rows (defined by the Disk Bay Layout) as
columns in the Disk Bays View.

Show Disk Bays in Tree View
Switches Disk Bays View to Tree View for user convenience and customization related
to the one configured in Disk Layout Editor.
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Figure 23: Tree View Layout

Edit Disk Bay Layout
Opens Disk Layout Editor for current layout customization or creating a new layout.

Related information
Disk Explorer on page 25
Local Devices View on page 31
My Computer View on page 33
Disk Layout Overview on page 16

Local Devices View

Local Devices View shows all disks recognized by OS and available for application in a List View:
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Figure 24: Local Devices View

Customize menu

Show System Devices
Displays the disk where OS installed

Show Not Ready Devices
Displays devices not yet initialized and used by OS

Show Removable Devices
Displays all removable and externally connected disks (such as USB's)

Compact View
Changes the layout of the Disk View from display block to inline block orientation.
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Related information
Disk Explorer on page 25
Disk Bays View on page 28
My Computer View on page 33

My Computer View

My Computer View presents the Disk Bay Layout in a standard list form, much like the disks in
Windows Explorer. Disk Bays are grouped by row and can be colored according to their batch color.
Information such as disk status, serial number, partitioning are shown in list form next to their respective
Disk Bays. Properties window at the right side displays attributes of the currently selected object.
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Figure 25: My Computer View

Customize menu

Show My Computer
Displays all devices that are detected by the system Device Manager.

Show System Disk
Displays the disk containing the Operating System. This is off by default to prevent
accidental erasure of the system.

Show Unallocated Partitions
Displays partitions that may not yet been formatted.

Show Devices
Switches between display of devices (physical disks containing volumes) and "volumes
only" display.

Show Removable Disks
Displays removable media storage (USB Flash Disk, External USB etc.).

Show Not Ready Devices
Displays devices that may not yet been initialized and accessed by the OS.

Navigator Pane
Shows/hides Navigator Pane (on the right side of the View)

Related information
Disk Explorer on page 25
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Disk Bays View on page 28
Local Devices View on page 31

Using Disk Clone

Disk Clone Industrial is a powerful industrial tool to provide disk cloning and erasure solutions for large
workstations with many disks. The features in the Disk Clone Industrial software are built with this goal
in mind. This section describes the key features of the software and how they are used to erase/clone
single disks and images to large batches. The software is highly customizable and this guide will help get
you started with configuring Disk Clone Industrial for your system and using it to the full potential.

Disk Clone
To clone a disk (or image to a disk) follow the steps below.

1. Navigate to the Disk Bays View on page 28 and select a disk to clone. For multiple selection use Ctrl
+Left Mouse Click or row\column selection buttons. If none of drives is selected, the user must select
the source and targets on the next step.

Figure 26: Disk Bays View disk's selection
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2. Click Clone Disk in main or context menus (Actions > Clone Disk as alternative) and select targets
(if one disk was selected in previous step) or select source (if multiple disks were selected) and click
Clone.

Figure 27: Targets selection for cloning
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Figure 28: Source selection for cloning
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3. Next is the main work cycle settings' dialog. Available (configurable) options are:

• General Settings on page 76
• Disk Erase on page 44
• Disk Clone on page 35
• Processing Report
• E-mail Notifications on page 92
• Error Handling on page 90

Figure 29: Cloning options

User is able to review and edit cloning options:
Clone Source
Selected bay or image as a source for cloning
Clone Source
Selected bay or image as a source for cloning

Confirmed clone targets
Selected targets (Bays) where to clone
Confirmed clone targets
Selected targets (Bays) where to clone

Print clone labels for each disk using Disk Label Preset is an optional feature for providing a
specific label for each disk in work cycle according to presets.

Note:
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Figure 30: Targets will be DECLINED if configuration is invalid

Start copy to sector stands for specifying a sector where the cloning starts and
considered as a advanced feature activated by pressing Show Advanced button:

4. When all the settings are verified press Start button. The work cycle starts and user is able to see
the progress in Disk Bays and Local Devices Views. The progress bar represents the percentage
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of disk space processed. As the procedure progresses the percentage increases and estimated time is
recalculated.

Note:  If preliminary Disk Erase on page 44 procedure is configured and selected (activated),
it starts first, right before an actual cloning.

Figure 31: Disk Clone Progress (Local Devices & Disk Bays Views)
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Figure 32: User is able to STOP the process at any time (main menus and context menu)

When the work cycle is succeeded (or failed) the Processing Report  on page 49 dialog appears for
reviewing and further actions.
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Figure 33: Disk Clone Success (Local Devices & Disk Bays Views)

Related tasks
Disk Erase on page 44
Mount Disk Image on page 42
Related information
Clone Sources on page 80
Disk Label Presets on page 86

Mount Disk Image

To use image file as a data source for one or several disks
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1. To open the Mount Disk Image dialog do one of the following:

Figure 34: Mount Disk Image selection

Figure 35: Mount Disk Image selection (Preferences)
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2. Mount Disk Image dialog appears:

Figure 36: Mount Disk Image dialog

Disk Image file name
Full path to the image file

Caption (Display name)
Enter any label to distinguish newly opened (mounted) disk image among other devices
and disks.

3. Confirm and open disk image

Click OK to mount a Disk Image.

If disk image opens successfully then disk image node appears in Disk Explorer View and will be
available as a clone source in Clone Sources on page 80 tab and in drop-down list of clone sources in
task dialog.

Related tasks
Disk Clone

Disk Erase
Fast disk erase is a core part of Disk Clone functionality. Individual disks (or batches of disks) can be
erased during the process of cloning according to the standards with just a few clicks.

Note:  User is not able to activate the Erase Procedure without subsequent Cloning. For effective
erasure using more than 20 required international sanitation standards (U.S. DoD 5220-22M,
Canadian OPS-II, British HMG IS5 Enhanced, US Army AR380-19, German VSITR, Peter Gutmann
etc.) use LSoft's premium product KillDisk Industrial https://www.killdisk-industrial.com

To add an erase procedure to the work cycle:
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1. Navigate to the Erase Disk tab when you go through the clone settings and check the Use Disk
Erase box as shown below.

Figure 37: Erase Tab

2. The Disk Erase Options tab provides settings' configuration for the Disk Clone erase procedures.
The same erase options for each batch could be set through Edit Batch Attributes on page 63 dialog.
Choose the erase method from dropdown list.

3. If erasure verification is required select it and set a percentage of disk to be verified after erase
procedure.
After the erasure is completed this feature scans the entire drive evenly and verifies the integrity of the
erase operation. This option is the percentage of the sectors to check across the disk. Most standards
specify 10% as an accurate sample size for the verification.

4. Click Start button to begin the disk erase process (with the following cloning)

© 1999 - 2020 LSoft Technologies Inc.



 | Using Disk Clone  | 46

5. Observe erase process

When the Erase procedure begins you see the disk area representation as a progress bar as well as an
erase method and its progress. The progress bar represents the percentage of disk space processed. As
the procedure progresses the percentage increases and estimated time is recalculated.

Figure 38: Disk Erase Progress (Local Devices & Disk Bays Views)

User is able to STOP the process at any time (main menus and context menu)
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When the erasing is done with no errors, the final stage starts immediately: data cloning from source to
all the successfully erased disk(s).
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6. When all the procedures are completed the Disk Bays and Local Devices Views report the status of
the work cycle

Figure 39: Disk Erase (and Cloning) Completed (Local Devices & Disk Bays Views)

At the final stage user is able to review results (logs, processing reports and attributes) and print Disk
(clone) Labels for processed disks.
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Figure 40: Summary

Related information
Erase Methods (Sanitation Standards) on page 98
Processing Report on page 49
Labels and Reports on page 51

Processing Report
Once Disk Clone finishes processing all the tasks, a summary dialog appears. It contains all of the
information regarding to the operation(s). For example, it includes information like disks operated on,
status of cloning and erasure, logs and all associated labels and reports.

Figure 41: Example of task complete dialog
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Results Overview window contains the options for the successful erasure:

Title
All the devices processed are displayed with their success/failure status in TreeList-format.
Title
All the devices processed are displayed with their success/failure status in TreeList-format.

Status
An actual status (success/fail)
Status
An actual status (success/fail)

Erased
Status of the disk erase operation
Erased
Status of the disk erase operation

Cloned
Status of the disk clone operation
Cloned
Status of the disk clone operation

Started at
Time & date of operation's start
Started at
Time & date of operation's start

Duration
Duration of the operation
Duration
Duration of the operation

Processing Attributes window contains all the status and attributes of the operations (as more detailed
View)

Figure 42: Summary Processing Attributes sample

Log window shows an actual Log file.
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Figure 43: Log view sample

Clickable options are:

Print Labels
Allows user to examine, customize, change options and print Disk Labels on page 55 by pressing the Print
Labels button.

Print Labels
Allows user to examine, customize, change options and print Disk Labels on page 55 by pressing the Print
Labels button.

Disk Processing Report
Specifies the path to the saved Disk Processing Report. Allows user to examine the .xml disk processing report
by pressing the Browse (to navigate to the containing folder) or Open buttons.

Disk Processing Report
Specifies the path to the saved Disk Processing Report. Allows user to examine the .xml disk processing report
by pressing the Browse (to navigate to the containing folder) or Open buttons.

Related information
Labels and Reports on page 51

 Labels and Reports
Disk Clone maintains the highest standards in cloning as well as in disk erasure. The software provides
extensive documentation options for those operations with Reports and Labels features

Related information
Disk Processing Reports on page 51
Disk Labels on page 55

  Disk Processing Reports

Disk Clone gives you the option to save XML reports for all the operations it performs on a disk(s).

In order to get the reports generated, simply select and configure them during the process of Disk Clone
on page 35 setting or in Processing Report Preferences.
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Report Location
Specifies the path for XML-files to save.
Report Location
Specifies the path for XML-files to save.

File name template
Allows user to use Name Tags on page 99 for building a file name. Preview shows how the tags build the
file name string.

File name template
Allows user to use Name Tags on page 99 for building a file name. Preview shows how the tags build the
file name string.

These reports may include (selected by user) all the information regarding to the Disk Clone procedures,
such as:
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Company Information

• Name
• License
• Location
• Phone
• Disclaimer

Company Information

• Name
• License
• Location
• Phone
• Disclaimer

Technician Information

• Name
• Comments

Technician Information

• Name
• Comments

System & Hardware Info

• OS version
• Architecture
• Kernel
• Processors
• Manufacturer

System & Hardware Info

• OS version
• Architecture
• Kernel
• Processors
• Manufacturer

Erase Attributes

• Erase verify
• Passes
• Method
• Verification passes

Erase Attributes

• Erase verify
• Passes
• Method
• Verification passes

Error Handling Attributes

• Errors terminate
• Skip interval
• Number of Retries
• Source Lock
• Ignore Write Error
• Ignore Read Error
• Ignore Lock Error

Error Handling Attributes

• Errors terminate
• Skip interval
• Number of Retries
• Source Lock
• Ignore Write Error
• Ignore Read Error
• Ignore Lock Error

Disks

• Device Size
• Device Type
• Serial Number
• Revision
• Product Number
• Name
• Geometric Information
• Partitioning Scheme

Disks

• Device Size
• Device Type
• Serial Number
• Revision
• Product Number
• Name
• Geometric Information
• Partitioning Scheme

Batches

• Name
• Disks
• Time

Batches

• Name
• Disks
• Time

Additional Attributes

• Fingerprint Information
• Initialization

Additional Attributes

• Fingerprint Information
• Initialization

Erase Result

• Bay
• Time and Date Started
• Disk Information
• Status
• Result
• Time Elapsed
• Errors
• Name of operation

Erase Result

• Bay
• Time and Date Started
• Disk Information
• Status
• Result
• Time Elapsed
• Errors
• Name of operation
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Figure 44: XML reports' samples:

Disk Labels

Disk Clone allows you to print Disk Labels to place on erased disks with its Print Label features.  Disk
Labels with process results and essential disk information could be issued for any disk processing (such as
Disk Erase  or Disk Clone ). These labels may be completely customizable to print on any sized sheet with
any dimension. Simply specify the parameters and Disk Clone will prepare the printable labels for you.

Activating a Disk Clone Labels feature

When configuring a main work cycle select Print clone labels for each disk using Disk Label Preset
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Figure 45: Activating Print Clone Labels feature

Accessing the Print Labels Option

Upon the completion of a work cycle Disk Clone you will see a report dialog. In the list of completed tasks
you will see the Print Labels button. Click it to enter the Print Label Dialog.

Figure 46: Opening Print Label Dialog
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Print Label Dialog

This dialog allows you to configure the labels and prepare them for printing. The top of the dialog shows
a list of the drives that will have labels generated for them. At any point in the operation a sample of the
label is shown in the Preview window on the left side. The right side of the dialog has the styling and
template configuration options.

Figure 47: Print Label Dialog

Page template options

The print label dialog gives you an access to a number of predefined standard presets and custom
templates you may create. These templates may be easily selected without opening any additional dialogs.
All the details of the selected template will be displayed below the selection box.

Print Start Position

The print start position section of the dialogue allows you to select what label on the page start printing
from. The labels won't always start from the 1x1 position so you can adjust this setting accordingly.

Print Preview and Printing

Once all the settings are configured you may see the Print Preview by clicking the Continue button. The
Preview displays what the print is going to look like and from here the print job can be sent to a printer
that is configured in the system.

Skip Print Preview
Disable system Print Preview dialog and print labels immediately.
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Figure 48: Example of a Print Preview

Related information
Disk Label Presets on page 86

Compact Operating Modes
Disk Clone has advanced operating modes simplifying product usage in the industrial environments.

Touch Mode & Kiosk Mode

Compact operating modes added to simplify routing tasks. In these modes user have an access only to the
features being used most frequently.

To switch to compact modes, select Kiosk Mode (or Touch Mode, depending on the product
configuration) from the View menu. Also, you can press Ctrl+T to switch to and return back from
compact modes.

All menus, toolbars and other supplementary windows, like Properties and Output will be hidden while
operating in compact mode. Access to commands is through floating menu at the bottom left corner of
application's main window.
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There are 2 compact modes available:

• Touch Mode - designed to support portable touch-screen monitors
• Kiosk Mode - works similar to previous one but also supports mouse and designed to support

commercial grade monitors. It attempts to show as many Disk Bays as possible at once, simplifying
visual control and ongoing processes for operator. This mode still supports mouse and giving access
to most advanced features.

To switch from compact mode back to windowed operating mode click the most right button (blue
computer monitor) at the bottom.

Disk Batches

Disk Batches are used to organize disks into groups depending on what the disks are being used for, type
of disk or the desired operation to be performed on them: Erase, Clone and combinations. User is free to
use disk batches in any manner. Disks can be added or removed from Batch at any time.
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Figure 49: Disk Batches distinguished by color

Once disks are batched together they may be treated as a group and similar settings may be set for this
batch. Likewise, operations may be performed on these batches - initiating the operation on a batch
performs the operation on all the disks in the batch.

Related tasks
Assign Disk Bays to Batches on page 62
Related information
Create / Delete Batches on page 60
Edit Batch Attributes on page 63

Create / Delete Batches

Create a Disk Batch

Disk batches are created using the Batch Control toolbox.

Note:

If you can't find the Batch Control toolbox make sure that you have a proper View activated. To do
this navigate to the file menu bar and click View > Windows > Batch Control. There should be
a check mark next to the Batch Control View.

In the Batch Control toolbox click New Batch. This will open the Create a New Batch configuration
wizard. After configuring batch settings click Finish and the new batch will appear in the Batch Control
window.

© 1999 - 2020 LSoft Technologies Inc.



 | Disk Batches | 61

Figure 50: Batch Control Toolbox

Adding disks to a Disk Batch

Disk Bays can be added to Batches in several ways:

• From Disk Bays View
• From Edit menu

Read Add Disks to Batches for more information.

Removing disks from a Disk Batch

Disks are removed from a Batch in a very similar way to the way they are attached. Follow the same
steps as with Adding Disks but select bays that are attached to batches and choose the Detach Bays
command.

Deleting Batches

Batches can be deleted by selecting the batch in the Batch Control toolbar and choosing the Delete
Batch or Remove All commands.
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Edit batch attributes

Batch attributes can be edited at any time after batch created. See: Edit Batch Attributes on page 63

Note:

Disk batch attributes changed every time if altered in confirmation dialog.

Related tasks
Assign Disk Bays to Batches on page 62
Related information
Disk Batches on page 59
Edit Batch Attributes on page 63

Assign Disk Bays to Batches
Disk Bays can be assigned to existing disk Batches in order to apply same batch attributes for selected
tasks (disk erase, cloning etc).

Note:

Single Disk Bay can only belong to one Batch.

Disk Bays are assigned to Batches in one of several ways:

From Disk Bays View

Figure 51: Assign Disk Bay through the Disk Bays View

1. In the Disk Bays View: select the disk(s) that you'd like to place in a Batch.
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2. Right-click on the disk.
3. Hover the Assign Bays to option to see a list of available Batches.
4. Select the desired Batch from the list to place the selected disk into.

From Edit menu

Figure 52: Assign Disk through the Edit menu bar

1. In the Disk Explorer: select the Disk Bay(s) that needs to be assigned
2. Click Edit menu bar
3. Hover the Assign Bays to action to see a complete list of available Batches
4. Click on the desired Batch. The selected Bay(s) will be assigned to that Batch.

Edit Batch Attributes
After creating a new Disk Batch user is able to work with Edit Batch window where the Disk Batch
settings may be changed. For existing Disk Batches it is possible to access this window by selecting the
desired Batch in the Batch Control toolbox and clicking Edit Batch.

Batch General Options

These are General Settings for the Batch (such as Title, Color, how the Batch is displayed etc.)
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Figure 53: Batch Editor - General Settings

Company Information

These settings allow user to configure Company Information for Batch Processing Reports.

It is the same form as in Preferences > Company Information

Technician Information

This setting allows user to configure Technician Information for Batch Processing Reports.

It is the same form as in Preferences > Technician Information

Disk Erase

These settings configure disk erase settings for the Batch. Erase methods, verification and report settings
can be changed here.

Disk Clone

This feature allows user to configure either a disk or disk image for cloning to all the disks in the batch.
Available for Erase Batches with examined disks only.

Read Clone Sources on page 80 for description of each attribute.

Batch Report

These settings give user an option to toggle whether or not to issue an erasure XML report upon erase
and configure the options to include (like a name, destination, S.M.A.R.T. details etc.). Options for issuing
individual XML reports for the particular disks in the batch can be configured.

Read Processing Report on page 83 for description of each attribute.

Email Notifications

User can turn on email notifications for Batch operations and attach a Certificate, XML Report and
Erase Log to the email.
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Read E-mail Notifications on page 92 for description of each attribute and SMTP settings configuration.

Disk Labels

User can turn on displaying and printing disk labels after Batch operation is completed. As well as
configuring a default printer and customizing label templates.

Read Disk Label Presets on page 86 for description of each attribute.

Error Handling

For each Batch error handling attributes can be set individually. S.M.A.R.T. attributes may also be
configured in error handling by clicking SMART Diagnostics button.

Read Error Handling on page 90 for description of each attribute.

Related information
Disk Batches on page 59
Create / Delete Batches on page 60

Advanced Tools

Disk Clone offers a number of advanced tools to work in conjunction with the software to make
operations easier to perform and the disks easier to navigate. Disk Clone makes it possible to browse
through disks on both: a file level and a low, hexadecimal (HEX) level. Disk health analysis with its
S.M.A.R.T. monitor as well as logs/reports export to the external databases fully supported in Disk Clone
Industrial version. This section describes each of these features:

• File Browser
• Hexadecimal Viewer

File Browser
Disk Clone includes a built-in File Browser for examining the contents of disks for verification purposes,
for hard drives' selection control or for erased files validation after erase . Details on using this feature are
discussed in this section.

Opening the Browsing View

To browse the contents of a specific disk from the Disk Bay Layout View simply select the desired disk
and click Browse Disk in the action toolbar or select the related command from the context menu.
Shortcut is Ctrl-B.

© 1999 - 2020 LSoft Technologies Inc.



 | Advanced Tools | 66

Figure 54: Launching the File Browser

This will open the File Browser tab:

Figure 55: File Browser Window

The File Browser tab displays files and folders on the disk being selected.

The File Browser tabbed View may also be manipulated by navigating to the Customize button at the
top. Here you have options to adjust:
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Show System Files
Toggles advanced disk information (system files) being shown
Show System Files
Toggles advanced disk information (system files) being shown

Show Unallocated Partitions
Toggles the unallocated disk partitions being shown
Show Unallocated Partitions
Toggles the unallocated disk partitions being shown

Navigator Pane
Toggles the Navigator Pane View ON and OFF.
Navigator Pane
Toggles the Navigator Pane View ON and OFF.

Note:  Found deleted files appear in their original directory (before they were deleted). The ! Lost
& Found ! folder is a virtual directory created for found deleted files with not discovered directory
information.

Disk Viewer
Disk Viewer allows users to view the contents of connected drives on a sector's level in a hexadecimal,
ASCII and Unicode representations. User is able to launch Disk Viewer on all main Disk Explorer Views
(Disk Bays, Local Devices, My Computer) as well as through the main menu bar. Shortcut is Ctrl-H.
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Figure 56: Disk Viewer with the MBR Template

Disk Clone also offers a list of templates to help display the organization of the sectors on the disk by
colored sections. The above uses the MBR template, below is a template for NTFS file system boot sector.

Figure 57: NTFS Boot Sector Template

The Disk Viewer also includes a Find feature for locating specific data in the low-level disk View

Find what
Input the characters you are searching for in ANSI, Hex or Unicode
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Search Direction
If you have an idea of where the data may be located specify where to search

Not
Search for characters that do not correspond to the Find what parameter

Ignore case
Disables case-sensitivity in the search

Use
Select between Regular Expressions and Wildcards

Per block search
To speed up the search process (if you are familiar with the location of the data in the data
block) you may specify a search with an offset of the object

Figure 58: Finding Data

Disk Viewer's Navigate feature allows:

Go to Offset
Jumps to the particular offset that needs to be entered manually in a decimal or
hexadecimal format

Go to Sector
Jumps to the particular sector or cluster on the disk

Partition Table
Jumps to the sector where partition table is located

Particular Partition
Lists all partitions and allows to jump to the boot sectors, to the beginning and to the end
of any available partition.
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Figure 59: Disk Viewer Navigation Options

S.M.A.R.T. Monitor
Disk Clone supports displaying S.M.A.R.T. information. Just navigate to the file menu bar and selecting
Tools > SMART Monitor. It opens the S.M.A.R.T. monitor window shown below:

Figure 60: S.M.A.R.T. Monitor

S.M.A.R.T. Information

The S.M.A.R.T. monitor displays a list of all discovered disks and shows the S.M.A.R.T. information next to
them in table format. The following S.M.A.R.T. information is shown as separate columns:

• Display Name
• Device Model
• Serial Number
• Firmware Version
• Read Error Rate
• Reallocated Sectors Count
• Spin-up Retries
• Command Timeout
• Reallocated Event Count
• Current Pending Sectors
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• Reported Uncorrectable Errors
• Soft Read Error Rate
• Read Error Retry Rate

Configurable Settings

These are the parameters to be configured in the Settings drop-down menu on a toolbar:

Monitored disks
Here you have the option to either display All Disks seen by the system or only the Active (processing) disks.
Monitored disks
Here you have the option to either display All Disks seen by the system or only the Active (processing) disks.

Refresh Rate
This specifies the interval in seconds between updates to the S.M.A.R.T. information displayed when the
S.M.A.R.T. monitor is running.

Refresh Rate
This specifies the interval in seconds between updates to the S.M.A.R.T. information displayed when the
S.M.A.R.T. monitor is running.

Running the S.M.A.R.T. Monitor

The S.M.A.R.T. monitor can either be refreshed manually or run to keep the information current. To run
the S.M.A.R.T. monitor simply click the Start button in the action toolbar. To pause or stop auto-refreshing
sequence click Pause or Stop buttons in View's toolbar accordingly.

Note:

S.M.A.R.T. monitoring is a process that requires a lot of resources. It can slow down erase/clone
process significantly. We advise you to avoid querying S.M.A.R.T. information very often.

Troubleshooting and System Recovery

In the event that you experience any technical difficulties with Disk Clone you may choose to either
troubleshoot the system yourself or, if you have an active support and updates (you receive 1 year free
with your purchase), contact our support team and attach your application log and hardware configuration
file (hardware diagnostic)

Common Troubleshooting Tips
Disk data is not erased

Ensure you are not erasing the system disk from the application.

Erased the wrong disk
Stop the operation as soon as possible. Once data is sanitized by erase features it will
no longer be accessible. Use a tool like Active@ File Recovery (https://www.file-
recovery.com) to recover any data that has not been sanitized yet

Application Log
This Log View reflects every action taken by the application and displays messages, notifications and
other service information. Use the messages in this screen to observe and further analysis of the recovery
process.

To open and activate Application Log View do one of the following:

• From main menu choose Tools > Application Log or
• Use F8 keyboard shortcut at any time
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It is best to save the log file to a physical disk (different from the disk that holds the deleted data). By
doing this you reduce the risk of writing over the data that you are trying to recover.

Figure 61: Application Log View

Figure 62: Application Log View

Save Log As
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Opens a standard save as dialog. Save the actual application log file to the local disk
(default extension is .log)

Save Hardware Info as
Opens a standard save as dialog. Save the disk diagnostic file to the local disk (default
extension is .xml)

With sub-menu the following items are available:

Log entry filter

Shows or hides specific entry types in Log View:

Minimum details
Shows non-critical warning entries

Maximum details
Shows advanced entries related to the application behavior and data analysis

Text size
Changes text size to Large, Normal orSmall

Expand All
Expands a tree log data if available

Collapse All
Collapses a tree log data if available

Clear
Clear log for current application sessions

It is possible to go through the options with the context menu (right mouse click).

Figure 63: Context menu

Tip:  We recommend that you attach a copy of the log file to all requests made to our technical
support group. The entries in this file will help us to resolve certain issues.

Hardware Diagnostic File
If you want to contact our technical support a file that contains a summary of your local devices is helpful.

Disk Clone allows you to create a summary listing file in XML format. This data format is “human-
readable” and can help our technical support staff to analyze your computer configuration or point out disk
failures or abnormal behavior.

Create a hardware diagnostic file from the File menu by clicking the Save Hardware Info as... button.

Note:  To save time when contacting our technical support staff we highly recommend that you
provide us with a hardware diagnostic file.
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Related information
Application Log on page 72

Preferences

Disk Clone Preferences window is the central location where Disk Clone features can be configured.
These features are divided into several tabs.

To open Preferences dialog:

• From main menu choose Tools > Preferences... or
• Use F10 keyboard shortcut at any time

Preferences dialog could be open from other task dialogs to change related settings.

• General Settings on page 76

• Environment
• Sound Notifications
• Action Triggers

• Clone Sources
• Company Information
• Technical Information
• Processing Report
• Disk Label Presets

• Disk Label Templates
• Disk Viewer
• Error Handling

• S.M.A.R.T. Diagnostics
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• E-Mail Notifications

• SMTP Server Setting

Preferences allow users to configure all the global settings for the application.

Notice:  When General Settings, Disk Label Presets, Error Handling or E-mail Notifications
command initiated smaller subset of these settings is available to modify.

General Settings
The General Settings allow to configure general application settings as well as the visual aspects of the
application.

These are configurable options pertaining to the applications functionality.

Device Control Layout

These settings control visual disk behavior in Disk Explorer on page 25 and allow to Show or Hide
system disk and devices which are not ready (offline)

Default Serial Number detection method
Select how Disk Clone retrieves the disk serial number by default. Values are: SMART,
IOControl & WMI

Local Devices Initialization
Select which types of devices appear in Disk Clone by default: Fixed disks, Removable
disks, CD/DVD/BD and Floppies

Computer ID
Configure how the Disk Clone workstation is identified in logs & reports. Values are:
None, BIOS Serial Number, Motherboard Serial Number

Application Log File Settings

These settings apply to the log file generated by the application. All operations performed in a Disk Clone
session will be saved in this log.

© 1999 - 2020 LSoft Technologies Inc.



 | Preferences | 77

Log file location
Allows the user to specify where the application log file is saved. By default this is set to a
Disk Clone installation directory

Application log detail
Manipulate the amount of details included in the logs. Options are: Minimum and
Maximum

Initialize application log when application starts
This setting configures whether Disk Clone generates a new log file for every session
(erasing the log of the previous session) or appends new sessions to one log file.
Moreover, logs can be placed to the files being named using naming pattern specified

Environment

These are configurable options pertaining to the applications user interface and user experience.

Application style
Configures the color scheme used in the application. Values are: Blue, Olive, None (Use
OS default) and Silver

Default toolbars style
Configures how icons are shown in the toolbar. Values are: Large icons, no text, Large
icons, with text beside icon, Large icons, with text under icon, Small icons, with
text beside icon, Small icons, no text
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Figure 64: Large icons, no text

Figure 65: Large icons, with text beside icon

Figure 66: Large icons, with text under icon

Figure 67: Small icons, with text beside icon
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Figure 68: Small icons, no text

Default help source
If available, user can select help documentation source to be addressed when requested.
Values are: PDF, CHM and On-line web help

Reset All Dialogs
Pressing the button resets all the changes to default state.

Sound Notifications

These are configurable options related to application sounds: you can use either predefined values or
assign your own sounds (<User defined sound file>)

Use Sound Notifications
Toggles sound tones being used for notifying the user of the completion of a task, errors
and notification during an operation: Success/With Warnings/With Errors/Failures
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Action Triggers

Configure actions performed while application is running

Automatically check for software updates
If this option set, application will check for a new updates during every start up

Action after all processes complete
Select either None, Hibernate, Shutdown or Restart system after all processes have
been finished

CAUTION:  You will have 30 seconds to abort system hibernation, restart or
shutdown.

Export erase certificates and application log to all detected removable media
Upon erase completion all certificates and logs will be automatically exported to attached
USB disks (removable media)

Clone Sources
This preferences tab allows you to select a master-copy disk to use for cloning to other disks after they
have been erased.
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Selecting a Disk for cloning

Any disk recognized by Disk Clone may be used as a master-copy for Cloning. Simply find the disk under
the Available Disks column and check the box next to the desired Disk Bay. This disk will be locked and
read/write operations will be restricted for it until the cloning operation is complete.

Selecting a Disk Image for cloning

Additionally to cloning a disk, cloning can be done from a mounted disk image. In the Disk Clone
preferences tab:

1. At the bottom of the dialog, click Mount Disk Image

Figure 69: Mount Disk Image dialog
2. To the right of the "Disk Image file name" field click the ... button
3. Find the desired disk image in the file explorer and click Open
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4. Fill in the "Display name" text box with a desired name for the image and click OK
5. The mounted disk image should appear under Disk Images in the Master-copy sources window.

Note:  To avoid repeating steps 1-4 every time the application is launched check the "Autoload
mounted Disk Images at every application start" box. This will complete the mounting
process automatically in the future.

Related tasks
Mount Disk Image on page 42
Disk Clone

Company Information
These settings allow user to configure Company Information for Erase Certificates.

To specify a Company Logo image just use the Set and Remove buttons. It allows you to select a
desired image with local File Explorer. Most of the image formats are supported: JPEG, TIFF, BMP, PNG
etc. The logo will be previewed in the Company Logo space.

Tip:  It is recommended to use company logo with resolution suitable for printing (300dpi) with a
side not exceeding 300px.

Add all the company information to the related fields.

When the Add company supervisor signature field to certificate checkbox is selected the required
field is added to the actual certificate.

Related information
Erase Certificate

Technician Information
This setting allows user to configure Technician Information for Erase Certificates.
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Add Operator name and Comments to the related fields.

When the Add technician (operator) signature field to certificate checkbox is selected the required
field is added to the actual certificate.

Related information
Erase Certificate

Processing Report
These settings allow you to configure the XML reports generated by Disk Clone.

Report Location

User may configure where XML erasure reports are saved

File name template

Here you may specify the template for the XML reports. The main tags available are:

Available element: Tag:

Serial ID {Serial ID}

Erasure Status {Status}

Date of Erasure {Date(YYYY-MM-DD)}

Time of Erasure {Time(HH-mm-ss)}
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There are additional tags available (see the tags section in Appendix)

Include company information

Optionally adds the company information (defined in Company Information) into the XML
erasure report

Include technician information

Optionally adds the technician information (defined in Technician Information) into the XML
erasure report

Include system info

Ensures that the system-specific information is saved in the XML report, such as:

• Operating system
• Kernel version
• Architecture (x86, x64)

Include hardware info

Ensures that the system-specific information is saved in the XML report, such as:

• Motherboard manufacturer
• Motherboard description
• Host (name, domain)
• CPU (logical, physical)
• Memory

Include S.M.A.R.T. information for each disk

Optionally adds an additional information about disk health based on S.M.A.R.T. attributes
into the XML erasure report.

The Disk Clone XML report contains the following parts:

Table 1: XML Report Parameters (sample)

Type of Information Specific data

NameTechnician Information

Note

Name

Licensed

Location

Phone

Company Information

Disclaimer

OS version

Platform

System Information

Kernel

Motherboard Manufacturer

Motherboard Description

Hardware Information

Number of Processors
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Type of Information Specific data

Erase Verify

Passes

Method

Erase Attributes

Verification Passes

Errors Terminate

Skip interval

Number of Retries

Lock

Source?

Ignore Write?

Read?

Error Handling Attributes

Lock?

Device Size

Device Type

Serial Number

Revision

Product Number

Name

Geometric Information

Disks

Partitioning Scheme

Fingerprint InformationAdditional Report Attributes

Initialize disk?

Bay

Time and Date Started

Disk Information

Status

Result

Time Elapsed

Errors

Results

Name of operation

Conclusion Overall result of the operation

Note:

If internal tag <task> is present the Result is appeared inside.
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Related information
Name Tags on page 99

Disk Label Presets
These preferences help to adjust label settings for the Disk Clone system globally. Labels may be
formatted for any printer, page or label type (device) using Disk Clone highly customizable labels'
features.

Label preset

Displays and let you select a default Label Preset or create a new one. Add New Label Preset button

 allows you to create a custom label preset with your own specifications. Delete button  deletes
the selected label preset

Label title

Allows you to set a title to be printed (in bold) at the top of the labels. It can be company name, batch
name or any other descriptors you may consider useful to identify the operation. Static text can be typed
in or any dynamic attributes (tags) can be inserted at current cursor's position. Click Insert Name Tag

button  to insert predefined tag from the drop-down list

Label Area

Label's content for the preset. Static text can be typed in or any dynamic attributes (tags) can be inserted

at current cursor's position. Click Insert Name Tag button  to insert predefined tag from the drop-
down list. Click Clear Pattern button to empty all label's area
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Label Attributes

You can use RTF formatting and set Word Wrapping behavior using related check boxes

Add signature line
Toggling this "ON" places a line at the bottom of the label for the technician to sign off on
upon completion of the wipe

Add certificate logo
Includes the logo used in the certificate as a label's watermark background

Label preview

Displays a preview of one label with the current input settings. Refreshes when any adjustments are made
to the settings.

Print options

Define options for label printing including special label printers (Brother QL-570 etc.):

Default printer
Define printer to be used exclusively to print labels from the list of installed printers

Print output adjustments
The print output adjustments section of the dialogue allows you to vertically or
horizontally displace the position measured in specific print units to adjust to different
printers.

Print test label command will let you print Disk Label sample to verify your settings and selected layout
attributes.
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Page template

The print label dialog gives you an access to a number of predefined standard templates and to any
custom templates you may create. These templates may be easily selected without opening any additional
dialogs. The details of the selected template are displayed below the selection box. If your specific labels

differ from any of the templates available the  button allows you to create a custom template with your

own specifications. Additionally, the  button allows you to modify an existing template and the 
button deletes the selected template.

Print Start Position

The print start position section of the dialogue allows you to select what label on the page is the one to
start from. The labels won't always start from the 1x1 position, so you can adjust this setting accordingly.

Creating a new template

Upon clicking the  button the following template editor window appears. Descriptions of the
template editor options are listed below.
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Figure 70: Create a New Disk Label Template

Template Title
Here you may create a custom title for your template. This is the name to refer this
template when selecting it in the Print Label dialog.

Page
Here you can specify the dimensions of the page used to print the labels. This may be
selected from the list of standard sizes or defined using exact measurements.

Page margins
Page margins are defined for the top, bottom, left and right sides of the page.

Label Layout
These settings define how the labels appear on the page. You may define the spacing in
between labels on the page and the dimensions of the label grid. Once you've enter the
proper measurements Disk Clone will take care of the formatting.

Size units
The units of measurement may vary between millimeters, inches, pixels and points. If
a value in entered in one measurement and the unit size is changed the appropriate
conversion will take place.
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Disk Viewer
These settings allow user to set hexadecimal View settings, font and interaction.

Hexadecimal offsets
Toggles offset format between decimal and hexadecimal

Show ASCII column
Toggles display content in ASCII format

Show UNICODE column
Toggles display content in UNICODE format

Lines to scroll
Number of lines to scroll for a single mouse wheel sweep

Pages to scroll
Number of pages to skip for a single PageUp or PageDown click

Bytes per line
Defines amount of bytes per line in binary display

Font name
Select any monospace font available for better experience

Font size
Font size to be used in binary view

Error Handling
Disk Clone has a wide capabilities to handle errors during continuous disk processing. Those are the
advanced settings to configure Disk Clone's error handling.
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Error handling attributes

Disk Clone allows user to select 1 of 3 ways to handle Read/Write Errors:

Abort entire disk group processing
This means that if user runs a Batch erase and one of the disks has errors the erase process for ALL the disks
in the batch is terminated

Abort entire disk group processing
This means that if user runs a Batch erase and one of the disks has errors the erase process for ALL the disks
in the batch is terminated

Abort only failed disk from group processing
This is the suggested setting. Failed disks return an error and terminate the erase process. But other disks in
the batch are not interrupted from the erase operation

Abort only failed disk from group processing
This is the suggested setting. Failed disks return an error and terminate the erase process. But other disks in
the batch are not interrupted from the erase operation

Ignore error for disk grouping
Ignores the read/write error and continues erasing wherever is possible on the disk. No active or forth going
operations are terminated

Ignore error for disk grouping
Ignores the read/write error and continues erasing wherever is possible on the disk. No active or forth going
operations are terminated

Terminate process after number of errors
Sets the error threshold to a certain amount before the disk operation is terminated and deemed unsuccessful
Terminate process after number of errors
Sets the error threshold to a certain amount before the disk operation is terminated and deemed unsuccessful

Number of Read/Write attempts
Sets the number of attempts Disk Clone makes to perform an operation when an error is encountered before
it stops execution

Number of Read/Write attempts
Sets the number of attempts Disk Clone makes to perform an operation when an error is encountered before
it stops execution

Ignore preceding results
Errors (if any) on previous steps (i.e. Examination) are ignored and following steps (i.e. Erase, Clone) will
be performed. If turned off the errors on previous steps will stop all further actions

Ignore preceding results
Errors (if any) on previous steps (i.e. Examination) are ignored and following steps (i.e. Erase, Clone) will
be performed. If turned off the errors on previous steps will stop all further actions

Use disk lock
Locks disks from being used by any other applications
Use disk lock
Locks disks from being used by any other applications

Ignore disk lock errors
Errors encountered with Disk Clone not being able to access locked disks are ignored
Ignore disk lock errors
Errors encountered with Disk Clone not being able to access locked disks are ignored

Ignore read/write errors
Toggle whether errors should appear for read/write errors
Ignore read/write errors
Toggle whether errors should appear for read/write errors

Rely upon disk performance
Set a minimum acceptable read/write speed in megabytes per second for disks to flag under-performing drives.
Rely upon disk performance
Set a minimum acceptable read/write speed in megabytes per second for disks to flag under-performing drives.
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S.M.A.R.T. Diagnostics

S.M.A.R.T. attributes may also be used in error handling. So threshold limits may be set on some or on all
of the disks S.M.A.R.T. parameters. This may speed up processing by immediately terminating operations
with unusable drives

Note:  Query execution for S.M.A.R.T. attributes is time and resource consuming operation. It can
interrupt disk erasure procedure for several seconds. Thus it is recommended to validate these
attributes not very frequently

Related information
S.M.A.R.T. Monitor on page 71

E-mail Notifications
Disk Clone can deliver results of its sanitation process by e-mail.
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XML Report and Application Log files can be sent to the email specified, just check the related option.

When user selects Use E-Mail Notifications option the next set of options: SMTP Server Settings will
be available for configuration in these Preferences.

SMTP Server Settings

These settings allow configuring mailer settings for delivering erasing/wiping reports to user's mailbox.
Simple Mail Transport Protocol (SMTP) is responsible for transmitting e-mail messages and needs to be
configured properly.

Account Type
Disk Clone offers you a free SMTP account located on www.smtp-server.com that
can be used for sending reports out. By default all the required parameters are pre-filled
and configured properly. The only field you need to type in is the e-mail address where
reports will be sent to. If your corporate policy does not allow using services other than
its own you need to switch this option to Custom Account and configure all the settings
manually. Ask your system/network administrator to get these parameters.

To
Type an e-mail address where erasing/wiping reports will be sent to
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From
Type an e-mail address which you expect these reports to come from

SMTP Server
Disk Clone offers you the use of smtp-server.com for a free SMTP account. This account
is pre-configured for Disk Clone users. Ask your system/network administrator to get the
SMTP server name to be used in the Custom Account

SMTP Port
For the free SMTP account Disk Clone allows you to use smtp-server.com on port 80.
This is a standard port being used by all web browsers to access the Internet. This port
most likely is open on a corporate and home networks. Other ports can be filtered by and
closed by a network firewall. Ask your system/network administrator to set up a proper
SMTP port for the related SMTP server.

SMTP Server authorization
To avoid spam and other security issues some SMTP servers require each user to be
authorized before sending e-mails. In this case a proper username and password are
required. Ask your system/network administrator to get proper configuration settings.

Appendix

Glossary

BIOS settings
Basic Input Output Subsystem is the program a personal computer's microprocessor uses to get the
computer system started after you turn it on. It also manages data flow between the computer's operating
system and attached devices such as the hard disk, video adapter, keyboard, mouse and printer. A typical
method to access the BIOS settings screen is to press F1, F2, F8, F10 or ESC during the boot sequence.

Boot priority
BIOS settings allow you to run a boot sequence from a floppy drive, a hard drive, a CD/DVD-ROM drive
or a USB device. You may configure the order that your computer searches these physical devices for the
boot sequence. The first device in the order list has the first boot priority. For example, to boot from a CD/
DVD-ROM drive instead of a hard drive, place the CD/DVDROM drive ahead of the hard drive in priority.

CSV-file
A comma-separated values (CSV) file is a delimited text file that uses a comma to separate values.
Each line of the file is a data record. Each record consists of one or more fields, separated by commas. The
use of the comma as a field separator is the source of the name for this file format. A CSV-file typically
stores tabular data (numbers and text) in plain text, in which case each line will have the same number of
fields.

Data Cluster
A cluster or allocation unit is a unit of disk space allocation for files and directories. To reduce the
overhead of managing on-disk data structures, the filesystem does not allocate individual disk sectors
by default, but contiguous groups of sectors, called clusters. A cluster is the smallest logical amount of
disk space that can be allocated to hold a file. Storing small files on a filesystem with large clusters will
therefore waste disk space; such wasted disk space is called slack space. For cluster sizes which are
small versus the average file size, the wasted space per file will be statistically about half of the cluster
size; for large cluster sizes, the wasted space will become greater. However, a larger cluster size reduces
bookkeeping overhead and fragmentation, which may improve reading and writing speed overall. Typical
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cluster sizes range from 1 sector (512 B) to 128 sectors (64 Kb). The operating system keeps track of
clusters in the hard disk's root records or MFT records. (See lost cluster).

Deleted boot records
All disks start with a boot sector. In a damaged disk (if the location of the boot records is known) the
partition table can be reconstructed. The boot record contains a file system identifier.

ISO
An International Organization for Standardization ISO-9660 file system is a standard CD-ROM file system
that allows you to read the same CD-ROM whether you're on a PC, Mac, or other major computer platform.
Disk images of ISO-9660 file systems (ISO images) are a common way to electronically transfer the
contents of CD-ROMs. They often have the filename extension .ISO (though not necessarily), and are
commonly referred to as "ISOs".

Lost cluster
A cluster that has an assigned number in the file allocation table, even though it is not assigned to any
file. You can free up disk space by reassigning lost clusters. In DOS and Windows you can find lost clusters
with the ScanDisk utility.

MFT records
Master File Table. A file that contains the records of every other file and directory in an NTFS-formatted
hard disk drive. The operating system needs this information to access the files.

Root records
File Allocation Table. A file that contains the records of every other file and directory in a FAT-formatted
hard disk drive. The operating system needs this information to access the files. There are FAT32, FAT16
and FAT versions.

Sector
The smallest unit that can be accessed on a disk. Tracks are concentric circles around the disk and the
sectors are segments within each circle.

S.M.A.R.T.
S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology; often written as SMART)
is a monitoring system included in computer hard disk drives (HDDs), solid-state drives (SSDs) and
embedded MultiMediaCards (eMMC) drives. Its primary function is to detect and report various
indicators of drive reliability with the intent of anticipating imminent hardware failures. When S.M.A.R.T.
data indicates a possible imminent drive failure, software running on the host system may notify the user
so preventative action can be taken to prevent data loss, and the failing drive can be replaced and data
integrity maintained.

Unallocated space
Space on a hard disk where no partition exists. A partition may have been deleted or damaged or a
partition may not have been created.

Windows system caching
Windows reserves a specified amount of volatile memory for file system operations. This is done in RAM
because it is the quickest way to do these repetitive tasks.
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Windows system records
The Windows registry keeps track of almost everything that happens in Windows OS. This enhances
performance of the computer when doing repetitive tasks. Over time, these records can take up a lot of
space.

Erase Disk Concepts

Erasing Confidential Data

Modern methods of data encryption are deterring network attackers from extracting sensitive data from
stored database files.

Attackers (who want to retrieve confidential data) become more resourceful and look for places where
data might be stored temporarily. For example, the Windows DELETE command merely changes the files
attributes and location so that the operating system will not look for the file. The situation with NTFS is
similar.

One avenue of attack is the recovery of data from residual data on a discarded hard drive. When deleting
confidential data from hard drives, removable disks or USB devices, it is important to extract all traces of
the data so that recovery is not possible.

Most official guidelines regarding the disposal of confidential magnetic data do not take into account the
depth of today's recording densities nor the methods used by the OS when removing data.

Removal of confidential personal information or company trade secrets in the past might have been
performed using the FORMAT command or the FDISK command. Using these procedures gives users a
sense of confidence that the data has been completely removed.

When using the FORMAT command Windows displays a message like this:

Important: Formatting a disk removes all information from the disk.

The FORMAT utility actually creates new FAT and ROOT tables, leaving all previous data on the disk
untouched. Moreover, an image of the replaced FAT and ROOT tables is stored so that the UNFORMAT
command can be used to restore them.

FDISK merely cleans the Partition Table (located in the drive's first sector) and does not touch anything
else.

Disk Clone Industrial is able to erase data on entire drive with a choice of One Pass Zeros and One Pass
Random international disk sanitizing standards

How fast?
An actual speed depends on many factors:

• HDD speed: RPM and SATA/SCSI/SAS type - the most important factor
• Disk Controller speed: SAS (6 Gbps/12 Gbps), SATA III (6Gbps), SATA II (3 Gbps), SATA I (1.5

Gbps)
• Computer overall performance (CPU + RAM)

For most modern computers and disks (manufactured within the last 5-7 years) SATA III standard is
supported, so erase speed is limited by HDD throughput (disk write speed) only.

Our tests give the results: 10 GB per minute (in average) per pass with decent computer
configuration and disks with age of up to 5 years old.

For example, 2 TB Toshiba disk has been erased on Windows platform with one pass within 3 hours and
32 minutes, 14 TB Western Digital disk - within 18 hours 53 minutes.
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The following snapshots are real-test certificates for erasing of:

1) 2 TB Toshiba (manufactured in 2015) SATA III (6 Gbps) 7200 rpm disk with One Pass Zeros showing
the average speed of 9 GB/min per pass

2) 14 TB Western Digital (manufactured in 2019) SATA III (6 Gbps) 7200 rpm disk with One Pass Zeros
showing the average speed of 12 GB/min per pass

© 1999 - 2020 LSoft Technologies Inc.



 | Appendix | 98

 Erase Methods (Sanitation Standards)

One Pass Zeros or One Pass Random

When using One Pass Zeros or One Pass Random standard, the number of passes is fixed and cannot
be changed. When the write head passes through a sector, it writes only zeros or a series of random
characters.
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Name Tags

General

{Computer ID}
Workstation (computer) ID
{Computer ID}
Workstation (computer) ID

{OS}
Operating System name
{OS}
Operating System name

{AppName}
Application name
{AppName}
Application name

{AppVersion}
Application full version
{AppVersion}
Application full version

{KernelVersion}
Kernel version
{KernelVersion}
Kernel version

{UniqueID}
Generated unique 8 symbols ID
{UniqueID}
Generated unique 8 symbols ID

Date & Time

Tags to represent current date in different formats:

{Date(YYYYMMDD)}
Complete date in full form without delimiters
{Date(YYYYMMDD)}
Complete date in full form without delimiters

{Date(YYYY-MM-DD)}
Complete date in full form with delimiters
{Date(YYYY-MM-DD)}
Complete date in full form with delimiters

{Date(YYMMDD)}
Complete date in short form without delimiters
{Date(YYMMDD)}
Complete date in short form without delimiters

{Date(YYYY)}
Year in full form
{Date(YYYY)}
Year in full form

{Date(YY)}
Year in short form
{Date(YY)}
Year in short form

{Date(Month)}
Full month name as literal
{Date(Month)}
Full month name as literal

{Date(MM)}
Month as digital with leading zero
{Date(MM)}
Month as digital with leading zero

{Date(DD)}
Day of month with leading zero
{Date(DD)}
Day of month with leading zero

{Time(HHmmss)}
Time with hours, minutes and seconds without delimiters
{Time(HHmmss)}
Time with hours, minutes and seconds without delimiters

{Time(HH-mm-ss)}
Time with hours, minutes and seconds with delimiters
{Time(HH-mm-ss)}
Time with hours, minutes and seconds with delimiters

{Time(HH)}
Hours with leading zero
{Time(HH)}
Hours with leading zero
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{Time(mm)}
Minutes with leading zero
{Time(mm)}
Minutes with leading zero

{Time(ss)}
Seconds with leading zero
{Time(ss)}
Seconds with leading zero

Disk

Values for these name tags retrieved from context device:

{Serial ID}
Disk serial number, retrieved from OS or from S.M.A.R.T. attributes
{Serial ID}
Disk serial number, retrieved from OS or from S.M.A.R.T. attributes

{Platform ID}
Disk platform identification (may be vary due to OS format)
{Platform ID}
Disk platform identification (may be vary due to OS format)

{Product ID}
Disk manufacturer Id
{Product ID}
Disk manufacturer Id

{Model}
Disk model name (if available)
{Model}
Disk model name (if available)

{Size}
Disk size in gigabytes
{Size}
Disk size in gigabytes

{Sectors}
Disk size in sectors
{Sectors}
Disk size in sectors

Processing attributes

Disk processing attributes based on execution conditions:

{Method}
Erase method
{Method}
Erase method

{Passes}
Erases passes description
{Passes}
Erases passes description

{Verified}
Verification attribute
{Verified}
Verification attribute

{DateStarted}
Process start date
{DateStarted}
Process start date

{TimeStarted}
Process start time
{TimeStarted}
Process start time

{TimeElapsed}
Process elapsed time
{TimeElapsed}
Process elapsed time

{Status}
Overall completion status for group processing or separate disk processing status.
{Status}
Overall completion status for group processing or separate disk processing status.

{StatusCode}
Overall process result digital code
{StatusCode}
Overall process result digital code

Item processing attributes

Item processing attributes based on execution conditions:
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{ProcessType}
Process type name
{ProcessType}
Process type name

{ProcessedAs}
Process short name
{ProcessedAs}
Process short name

{Range}
Processed disk range
{Range}
Processed disk range
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